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2 Frequently Asked Questions 
How do I create a new user account?  

Please contact Activated Content’s support services to activate your account. 

We can be reached by email at support@activatedcontent.com or by phone at 

1.206.448.3260 ext. 115.  

How do I Install the Encoder Workstation? 

Please contact Activated Content’s support services to activate your account. 

We can be reached by email at support@activatedcontent.com or by phone at 

1.206.448.3260 ext. 115.  

Why do I only see the home page and FAQ Links on the navigation bar?  

You have not logged into the site.  Please log into the site and try again.  If you 

log into the site and still are unable to see the download sections, your account 

has not yet been enabled.  You need to contact support by email at 

support@activatedcontent.com or by phone at 1.206.448.3260 ext. 115. 

How do I upgrade my installation to the latest build? 

Please contact Activated Content’s support services to activate your account. 

We can be reached by email at support@activatedcontent.com or by phone at 

1.206.448.3260 ext. 115.  

3 Introduction 
The Activated Content Watermarking Suite is a combination of three different applications that 

work together to allow a source album to be watermarked serially to a predefined group of 

distribution contacts. Each of the three applications has its own very useful role, and in some 

cases might be used by completely different users in your organization. 

The first application is the Encoder Workstation. The Encoder Workstation has two main 

functions. The first is to set up all of the information about the album so that the encoding 

machines know what to do. The information that gets entered during the Production Run 

Creation Wizard includes album name, artist name, and track names, and the names (or 

numbers) of the individuals that the albums are going to, as well as information about the 

production run itself. All of this information is placed on a central server so that it is available to 

more than one encoding machine at a time. The second purpose of the Encoder Workstation is 

to actually drive the process of watermarking and to send the watermarked files to the burner 

machine with instructions for burning and label printing. By going through the Load Source Files 

Wizard in the Encoder Workstation, the user is telling the encoding machine where it can 

mailto:support@activatedcontent.com
mailto:support@activatedcontent.com
mailto:support@activatedcontent.com
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physically find the tracks that are referenced in the production run information that were 

entered during setup. The encoder machine(s) can be networked to a Rimage or Microtech 

burner machine. 

The Burner Machine is a hardware CD duplication machine and corresponding set of 

applications provided by the CD burner manufacturer. This machine can be used by itself for 

tasks other than Activated Content watermarking. Activated Content watermarking only uses a 

subset of the functionality available on the Burner Machine. This documentation only includes 

the information necessary to make sure the Burner Machine is prepared for Activated Content 

watermarking. For more complete documentation on these and other features, refer to the 

documentation provided with your burner. 

The WinDecoder is the watermark detector and is a desktop application that can be used to run 

detections on known or suspect watermarked files. If it finds a watermark, it will contact the 

central server where the watermark information is stored, and return all of the information 

associated with the watermark that was entered during the setup wizard, including the contact’s 

name and organization that the album was sent to. 

More complete information on each of these applications is found in the sections below. 

4 Encoder Workstation 
Encoder Workstation is the desktop application that you will use to actually setup the 

watermark encoding and instructions for the burner. It includes the following tools: 

Create Production Run Wizard  

Load Source Files Wizard 

You can reach the Encoder Workstation in each of the following ways: 

 Double-click the “ACC Encoder Workstation” icon on your desktop  

 From the Start menu  All Programs  Activated Content Corporation  ACC Encoder 

Workstation 

4.1 Encoder Workstation Requirements 
Encoder Workstation requirements fall into three categories:  

 The network environment that the workstation needs to be installed in 

 The requirements for the machine itself 

 An appropriately setup configuration file 
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4.1.1 Connectivity and Networking 

The Encoder Workstation must be installed on an encoding machine that meets the following 

minimum networking requirements: 

 Be on a 100mbps network with the burner  

 Have a connection to the jobs folder on the burner. Typically this is mapped as the "M:\" 

drive.  

 Have a connection to the layouts folder on the burner (Microtech only). Typically this is 

mapped as the "L:\" drive.  

 Have it's "processed" directory accessible via a UNC path from the burner  

 Have port 80 or 8889 access to the internet with a connection sufficient to pass the 

network connectivity test found on the Activated Content Pre-install Checklist 

(http://www.activatedcontent.com/accPreinstall) 

In addition to these minimum requirements, it is recommended that the encoding machine be 

on a 1 GPS network with the burner. 

4.1.2         Machine Specifications 

There are a variety of encoding machines that the Activated Content Encoder Workstation runs 

on successfully, but the only recommended and supported hardware configuration is found on 

the Preinstall Checklist page (http://www.activatedcontent.com/accPreinstall). In addition to this 

hardware configuration, the following items are required: 

 Microsoft Windows XP Professional or Microsoft Vista (both with all of the latest service 

packs and patches)  

 Microsoft .NET Redistributable package (with all of the latest service packs and patches) 

In most cases, you might have the Encoder Workstation set up on more than one encoder 

machine, all networked to the same burner.  

  

http://www.activatedcontent.com/accPreinstall
http://www.activatedcontent.com/accPreinstall
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4.1.3         Configuration File 

Your installation engineer will have already set up your configuration file, and you will probably 

never need to modify it. However, if you have nonstandard requirements or wish to work with 

configuration yourself, you may need this reference. The configuration file is an xml file that can 

be edited with any text editor (such as Notepad). It is located at "c:\program files\activated 

content corporation\acc encoder workstation\acc encoder workstation.exe.config". The only 

settings that should be changed by an end user look like this: 

 <QSDK_Encode  

  data="4"  

  strength="0.03"  

  mark="Mark.dat"  

  times="0" 

  /> 

  

 <ACC_Encoder_Workstation  

  JobsPath="M:\"  

  ProcPath="c:\ac\processed\"  

  TempPath="c:\ac\temp\"  

  BatchPath="c:\ac\batch\"  

  ProcShare="\\encoder1\Processed\" 

  LayPath="L:\" 

  /> 

Here is what these values mean: 

 Data - The data insertion rate in bits per second.  

 Strength - The strength of the watermark. At the default strength above, the watermark 

is barely audible to a professional ear on professional grade high-fidelity audio 

equipment, but will be inaudible to almost every user and survives compression down 

to 48kbps.  

 mark – DO NOT alter this setting  

 Times -  The number of times that the watermark is inserted. "0" places as many 

watermarks in as possible.  

 JobsPath - Where to write out the job files that tell the burner what to do. Typically this 

refers to a networked drive on the burner machine.  

 ProcPath - The UNC path (usually local) that the watermarked track files should be 

written to.  

 TempPath - The local path for temporary files to be written.  
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 BatchPath - The local path that will be used for the placement of instantiated batches. 

This path will contain a directory for each locally instantiated batch which will in turn 

contain a "batch.xml" file that describes the batch.  

 ProcShare - A UNC path that the burner will be able to use to find the files referenced 

locally by "ProcPath".  

 LayPath - A path that the encoder machine will be able to use to find the layout files on 

the burner. The layout files are on the burner because that is where any images that 

were used in the layout reside. 

Please contact technical support if you wish to modify your configuration file so that we can 

maintain a record of your installation and ensure your system is in working order. 

4.1.4 Logging In and Permissions 

When you launch the Encoder Workstation (or any Activated Content application) you will have 

to log in with the username and password that you have been assigned by Activated Content. 

This is the same username and password throughout all ACC applications. Just enter your 

username and password and click "Next". This is case sensitive, so make sure that you are 

entering both username and password in the correct case. You will then come to the 

application’s home or welcome screen. 
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A note about permissions: There is a two-level permissions scheme operating in the background 

of all of the Activated Content applications. Activated Content can assign a separate username 

and password to each of your operators along with different permissions to different labels. For 

instance, for larger record companies, you may want one person at each label to have their own 

credentials that allows them access to the content related to that label only, while you may want 

an Encoder Workstation operator to have access to all of the labels’ jobs that you do business 

with. If you want Activated Content to set up a multiple user access scheme for you, please 

contact technical support at support@activatedcontent.com. 

4.2 Production Run Creation Wizard 
The Production Run creation wizard is a web based tool that is used to enter all of the 

information *about* the album batch that is about to be run, also called the “Production Data”. 

This information includes the following: 

 Batch Name  

 Media Owner (Label)  

 Album Name  

 Artist Name  

 Track Information (number of tracks, track names)  

 Release Year  

 Names (or numbers) of the people the album is being distributed to  

 ISRC Code  

mailto:support@activatedcontent.com
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 UPC Code  

 Track Gaps  

 Watermark Strength 

The production run name is to make it easier for the Encoder Workstation operator(s) to find 

out which production run to load source files for and run. The media owner sets up permissions 

about the content that is associated with the watermark. All of the other information is for asset 

management use. Use as little or as much of it as you want. Bear in mind that it won't be that 

useful if you find a watermark, but the only information that is associated with it is "Unknown 

Album, Unknown Artist, Distribution Contact 1". 

4.2.1 Welcome Screen 

When you have logged into the Activated Content Encoder Workstation and are at the 

application’s home page, you will see a list of four buttons on the left-hand side. To open the 

production run creation wizard, click the “Create Run” button. You should then see a window 

titled “Production Run Creation Wizard”. To continue, click the "Next" button. 
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4.2.2 Production Data 

You now be at the “Production Data” screen where you enter the top-level information about 

the production run that you wish to create. Here is a breakdown of what you are entering and 

why: 

 

 

 Media Owner- This is the name of you or your company that the Activated Content 

Encoder Workstation is assigned to and cannot be altered.  

 Production Run Name- Enter the name you wish to call this job. For example, “John 

Denver’s Greatest Hits Run Number Two”. Entering this information will give you a more 

complete record about the watermarks in the future.  

 Watermark Content- This option should always be selected for encoding your audio files 

with watermarks. 

 Gemini Copy Protection- In some Activated Content versions, Gemini Copy Protection is 

provided as an option. Check this box if you would like to copy protect the output CD. 

For most users, the option should not be enabled. 

 Sync Meta Data with IFPI- For Activated Content users that are IFPI (International 

Federation of the Phonographic Industry) members, you have the option to sync the 
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metadata of the job you are inputting so that the IFPI can monitor the Internet for your 

files. For Activated Content users that are not IFPI members, you will want to leave this 

box unchecked. (For more information about becoming an IFPI member, please contact 

sales@activatedcontent.com)  

 Number of Contacts- Enter the number of watermarked discs you wish to create for this 

run. This number will be used later in the wizard to create a form for you to fill in the 

names of all the contacts you are sending a disc to, if you so wish. Otherwise, a number 

can be issued instead.  

 Ordering Department- This field is for your internal use only and is designed for larger 

companies with many different departments to help keep track of jobs. It may also be 

left blank. 

Ordering Group- This is another field for your internal use designed to help keep track of jobs. It 

also may be left blank. 

Ordering Staff Member- This field is an internal identifier for your organization. It shows the 

individual that created the run. 

Once you have correctly entered all of this information, click the “Next” button. 

4.2.3 Asset Data 

The Asset Data screen is where you enter the information about the album you will be 

watermarking, such as the artist name, album name, etc. There are two options for entering the 

asset data. You can choose “Existing Album” or “New Album”.  

 

mailto:sales@activatedcontent.com
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The “Existing Album” option can be used when you are creating additional watermarked discs 

for a run or job you did in the past. This option will import the asset data from the previous run 

that you select from the window below the “Existing Album” option.  

The “New Album” option will be used more frequently. Once you select this option, you will be 

able to fill in the fields with the information corresponding to the job you wish to watermark. All 

of this information is solely for internal use on an ongoing basis. Here is a breakdown of what 

you are entering and why: 

 Artist Name- This is where you enter the name of the artist whose album is being 

watermarked, for example, John Denver. 

 Album Name- This is where you enter the name of the album that is to be 

watermarked, for example, “Greatest Hits”. 

 Release Date- This is where you can enter the planned release date of the album being 

watermarked, for example, “07/09/2006”. This date must be entered in the 

mm/dd/yyyy format. 

 Number of Tracks- This is where you enter the number of tracks that the album being 

watermarked contains, for example, “11”. 

 Internal Identifier- This field is provided for internal use. You can enter whatever 

information about the album that you would like, for example, “Second Mix”. 

Once you have successfully completed entering all of the necessary information on this page, 

click the “Next” button. 
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You will now find yourself at the second page for “Asset Data”. This is where you will enter the 

particulars of each track on the album. There are 3 fields for each track: 

 

 Track Name- This is where you enter the track’s name, if there is one. Otherwise, it can 

be left blank or represented by a number. 

 Company Code- This is field for internal use. You can add any information 

corresponding to each track you wish. 

Version (Mix) - Another field for internal use. Many times our record company clients have 

different versions of each song/track. This can help show which version is on this disc. 

Once you have correctly entered all of this information, click the “Next” button. 
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4.2.4 Distribution Contacts 

The purpose of the Distribution Contacts screen is to upload the list of distribution contact 

names. There are four ways  

 

 Standard - Manually enter a name for each one of the contacts that you indicated  

 File - Upload a list you created previously or that was exported from another system  

 Numbered - Each contact is assigned a numeric value  

 Existing - Use a previously created list of contacts 

You can choose which method you want to use by selecting the appropriate entry in the 

“Upload Type” pull-down menu. 

4.2.4.1 Distribution Contacts - Standard 

The “Standard” option for distribution contacts is for manually entering each contact's name. If 

you have chosen this method, simply enter a separate name in each field. If you wish to create a 

new group from the new contact names you can do so by selecting the “Create Group” button. 

When you are finished, click “Next”. 
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4.2.4.2 Distribution Contacts – Existing Groups 

Selecting the Existing Groups upload type will bring you to a screen where you can select from a 

number of preexisting group names. You will see a list of groups that you or one of your 

colleagues has already created in the past. You can checkmark one or more groups. After 

selection, click “Next”. 

 

4.2.4.3 Distribution Contacts – File Upload 

The “File Upload” option is an excellent method of entering a large number of names or 

importing a list of names from another system. The two formats that you can use are as follows: 
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 Comma Separated (Delimited) Values (CSV) - CSV is names separated by commas. It 

looks like this: 

 

                      John at Rolling Stone, Jane at Harpers, 

**NOTE**: You must insert a comma AFTER the last entry to instruct the program that the list is 

complete.  

 Carriage Return Delimited - Carriage return is a new name on each line. It looks like this: 

                            

                               John at Rolling Stone 

                               Jane at Harpers 

**NOTE**: You must hit “Enter” AFTER the last entry so that the cursor is at the beginning of the 

next blank line and the program knows the list is complete. 

 

Both of these file formats are very standard formats that you can save data to from a variety of 

applications, such as databases and spreadsheets. To use this method, complete the following 

steps: 

 Create a text file, for instance, with notepad (e.g."filename.txt") containing all of your 

contact names in one of the two formats listed above and save it to a location where 

you can find it. This process may be as simple as copying from an email into Microsoft 

Notepad or as complex as exporting a CSV file from Microsoft SQL Server.  

 Select "File Upload" for upload type  

 Click the “Browse” button and browse to the file you created above  

 Click "Open"  

 Select the radio button that corresponds to the file format you chose 
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4.2.4.4 Distribution Contacts – Numbered Upload 

The Number Upload option for distribution contacts should only be used if you absolutely 

cannot get the actual names from the person placing the order or discretion is of utmost 

importance. If you were asked to produce only numbered discs, you should use this method. 

When you later scan a suspect piece of audio, the only information related to the contact that is 

available will be the numeric value. The start number will normally be "1". However, if you have 

done a previous series and are asked to do "25 more from where you left off before", you can 

specify a different start number.  

*There is a limit of 500 contacts numbered in such a way for a production run. 

 

When you have correctly entered all the information, click "Next". 
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4.2.5 Confirmation 

You should now see a confirmation screen. Read through all of the information on the screen to 

ensure you have entered it all in properly. If you have made any mistakes, you can click the 

“Back” button until you reach the section with the errors and correct them. 

 

 

Once you’re finished, click the "Next" button. 
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4.2.6 Finished 

The Finished page will show you a message that your production run has now been created. This 

means you will now be able to find the name of the production run you just created listed on 

the server. 

 

Click “Exit” to close the Create Run window. 

4.3 Load Files Wizard  
The “Load Files” is the wizard within Encoder Workstation that allows you to select a production 

run from a list of job names that has already been created using the Production Run Creation 

Wizard. Here you will select the local audio files that constitute the album that you entered in 

the Production Run Creation Wizard previously. 

You launch the Load Files wizard by opening and logging into the Encoder Workstation and 

going to the Main Menu window, and then clicking the "Load Files" button from the menu on 

the left-hand sidebar. You should then see a new window pop up with a message that reads 

“Load Source Files Wizard”. 
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When finished, click the “Next” button. 

4.3.1 Find Production Run 

The “Find Production Run” screen is where you choose which production run name you want 

to load source audio files for and watermark. You can sort by each of the following 

columns/fields to help filter the results to find the production run you are looking for: 

 Media Owner  

 Title Contains 

 Date Range (From & To) 
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In addition, you can click on each of the column headings to sort by that column. We 

recommend sorting by the “Date Created” heading by clicking on the column heading to sort by 

the most recently created production runs on top. Once you have located the production run 

that you want to load source files for, select it to highlight it and then click “Next”. 

Note: Occasionally, a batch that you have created may not appear on this screen. Click the date 

column to sort by date, and click it again to sort by reverse date. This will make it appear. 

4.3.2 Hardware Configuration Report 

The purpose of the “Hardware Configuration Report” is to inform you whether or not all of the 

features specified in the production run are supported by your specific hardware configuration. 

 

**Note: Not all features are supported on all platforms. If you receive a warning, you should 

review and decide whether or not you would like to proceed with the current production run.  

If you are satisfied with the report, click “Next”. 
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4.3.3 Specify Source Files 

The “Specify Source Files” screen is where you select the audio files that are going to be 

watermarked. There are two options for adding the audio files. The first option is to “Rip Media 

From CD”. Select this option if you would like the Activated Content Watermarking Suite to rip 

the audio files from a CD for you and to use those files for watermarking. 

 

 

The second option is to “Use Existing Media Files”, or to use .WAV files already stored on your 

computer. Select this option if your audio files are already in .WAV format and ready to go for 

watermarking. Click the “Browse” button to explore your computer’s directories for the desired 

audio files. Select all the desired files, and click the “Open” button. You should now see the 

selected files listed in the window below “Use Existing Media Files”. 

The “Ripping Optimization” level-setter allows you to choose the level of speed and accuracy of 

ripping you would like to use. The faster the ripping speed, the less accurate the audio quality 

will be, and vice versa. Please use this option at your own discretion. We recommend leaving 

the setting at its default position. 

Once you are finished here, click “Next”. 
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4.3.4 Source File Ordering 

The “Source File Ordering” screen is where you have the option of reordering the audio tracks 

so that they match the names you entered for the tracks when creating the production run. 

 

To rearrange the order of any of the tracks, select a track to highlight it and then use the arrows 

on the right-hand side to move that particular track up or down to match up with the 

corresponding track name in the left-hand pane. The left-hand pane contains the names of the 

tracks in the order you entered them while creating the production run. 

Once you are finished here, please click “Next”. 
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4.3.5 Confirmation 

The “Confirmation” screen is a notification that the production run is ready to be watermarked. 

 

 

There is a checkbox option to “Begin Encoding Immediately” upon clicking the “Finish” button. If 

you would like for the watermarking to begin right away, check this option. If you would like to 

delay the watermarking process for any period of time, uncheck the box. If you elect to delay 

the watermarking process, the Encoder Workstation will finish setting up the job and store it for 

you.  

When you are ready to come back and encode the job, simply login to the encoder workstation 

and the job will be waiting in a list in the main window. Select the appropriate job to process, 

and click the “Process Selected Production Run(s)” button at the bottom of the window. 

**Note: You may need to logout and log back in order for the name of delayed jobs to appear in 

the main window’s list. 

  



 
 

26 Activated Content Encoder Workstation User Manual 
http://www.activatedcontent.com 

 

If you select to “Begin Encoding Immediately”, you will see a status window pop up. Click on the 

“Details” button to get a more in depth view of where the job is in the process.  

 

**Note: You may see a message that reads “Processing ended with the following exception: 

Server was unable to process the request.  Specified cast is not valid.” This IS NOT an error 

message; the production run was indeed completed successfully. 

4.3.6 Finish 

After the encoding is finished, a pop up window will appear and state that the job has been 

completed. Click the “OK” button to close the window. 

 

4.3.7 Process Production Run 

After you have locally set up a batch for processing by completing the batch setup wizard in 

Encoder Workstation, the batch will appear by name in the white window in the middle of the 

Encoder Workstation, below the Activated Content logo. To process this batch, follow these 

steps: 

 Make sure your burning application is open and running on the burner machine  

 Select the batch by clicking on it (Notice that the large button underneath the white 

window labeled "Process Selected Production Run(s)" is now active) 

 Click on the large button underneath the white window titled "Process Selected 

Production Run(s)"  
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 You will click through two intermediate steps that don't require you to do anything but 

click “Next” and then processing will begin right away. 
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5 WinDecoder (Watermark Detector) 

The WinDecoder program is a desktop application that can be used detect known or suspect 

watermarked files. If WinDecoder scans a file and finds a watermark, it will contact the central 

server where all of the watermark information is stored and return all of the information 

associated with that particular watermark which was entered during the Production Run Wizard. 

You can open WinDecoder by double-clicking on the desktop icon or by going to Start  

Activated Content Corporation  WinDecoder 

 

5.1 Login 

When you launch the WinDecoder you will have to log in with the same user name  

and password that you have been assigned by Activated Content for the encoder workstation. 

As noted, this is the same user name and password throughout all ACC applications. Simply 

enter your user name and password and click “OK”. This is case sensitive, so make sure that you 

are entering both your user name and password in the correct case. 

5.1.1 File Menu 

To begin decoding, from the “File” menu, click “Open”, then browse to and highlight the track(s) 

you want to scan. Double-click or hit Enter to send the selected files to the WinDecoder. 

The following fields are displayed on the WinDecoder screen: 

 File Name 

 File Information 
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 Decode State 

 Watermark 

 Content Owner 

 Artist Name 

 Track Name 

 CD Name 

5.2 Scan for Watermark 
Select one or more files at a time to be scanned by highlighting them and then clicking the “Scan 

Selected Files” button.  

The bar highlighting the track will change from green in color to yellow to red when the decode 

state changes from “Initializing” to “Decoding” to “Decoded”. Under the “Decode State” 

heading, the number in parentheses is a timer counting the seconds elapsed. 

Once Decoding is complete, the highlight bar will turn red and any watermarks found 

will be indicated under the “Watermark” heading. 

After a file has been scanned, it is archived to a folder titled “Scanned” inside the “Processed” 

folder from above: (C:/ac/processed/”contactname”/scanned)***  

***If this was selected in the Options menu - see below. 

5.2.1 Tools – Options 

In the Tools menu is the Options menu: 

 

The only items that should be changed in the Options menu are: 



 
 

30 Activated Content Encoder Workstation User Manual 
http://www.activatedcontent.com 

 

 Decode Data File Name- If there are multiple keys in use within your company, you will 

need to change the “Decode File Name” in order to retrieve the watermark successfully. 

For example "mycopy_Decode.Dat". Please contact Activated Content for further 

assistance. 

 Archive Source Audio File- It is a good idea to keep this box checked. When checked, the 

program puts all decoded or scanned music files into a folder titled "Scanned". This 

makes it much easier to keep track of which files have been decoded and which have 

not. 

6 Management Console 

The Activated Content Management Console is an internet application that displays the results 

of your encoding system activity. It shows details for either individual runs or groups of 

production runs. The data can be filtered by these headings: 

 Media Owner  

 Artist 

 From and To dates  

 Production Run  

 Production Run Details   

6.1 Logging In And Permissions 
In order to gain access to the Management Console, you will have to log in with the username 

and password that you have been assigned by Activated Content for the encoder workstation. 

This is the same username and password throughout all Activated Content applications.  

To access the Management Console, open your internet browser and visit 

http://services.activatedcontent.com/mgmt. Once there, enter your username and password and 

click the Log In button. These fields are case sensitive, so make sure that you are entering both 

username and password in the correct case. 

 

  

  

http://services.activatedcontent.com/mgmt
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6.2 Menu Options 
Once you have gained access to the Management Console, there are five menu options on the 

management console:  

 File 

 Reports 

 Exec Reports 

 Tools 

 Workstation Tools 

 

6.2.1 File Menu Options - Print 

When the Print option is selected from the File menu, a report will generate on screen and your 

printer window will open. If you would like to print the document on paper, click the “Print” 

button in the printer window. Otherwise, click “Cancel” and click the red “X” in the upper-right 

corner of the system report screen.  
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6.2.2 File Menu Option - Exit 

Clicking on the Exit option will return you to the login page.  

6.3 Reports 

The Reports Menu has two options:  

 Production Runs  

 Detections 

6.3.1 Reports - Production Runs 

Production Runs allows you to view the date the run was created, contact name(s), and status of 

the job.  

The Production Runs Report summarizes a run or runs. Filtering options are: 

 Media Owner - allows you to select one or many media owners from the list  

 Artist - allows you to select one or more artists from the list  

 From and To dates - allow for selections of a single date or a range of dates 

Once your selections have been made, click the Filter button. This will drop down a list of 

Production Runs that fit the selected parameters. 

6.3.1.1 Reports-Production Runs-Get Details 

Details can be displayed on a single run, or a group of several runs. Multiple selections can be 

made two ways: 1) Holding the Shift button while clicking to highlight different selections will 

select an entire section. 2) Holding the Ctrl button while clicking allows for multiple individual 

selections. 

After your selection, clicking the Get Details button will display more information about each 

individual run in the right panel of the window. Under the Production Run Details heading are 

these columns: 

 ID- Refers to an identification number generated by the Workstation Encoder  

 Created- Date the run was created 

 Contact Name- Name of the person or persons to whom the run was created by  

 Status- Indicates whether the run is Complete, Initiated, Not Initiated or Failed  

Media Owner- Refers to the date and time of the most recent change of a run’s status 

At the very bottom of the panel next to the Get Details button is a Summary showing the total 

number of runs, number of jobs, and the number completed. 
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6.3.1.2 Reports-Production Runs-Edit Contact Information 

Specific Job Details will pop up in a smaller window and allow for editing when a Production Run 

Detail item is clicked from the window at right. 

 

Under the Update Job Details heading, the Status can be changed by highlighting a job on the 

right side of the screen. Changing Status from Complete to Failed or Not Initiated will re-open 

the job for run. Once a Contact Name is changed from a numeral to a name (i.e. from "1" to 

"One"), it can not be changed back. 

 


